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This software is furnished in accordance with a separate license agreement included 
with the software, and subject to any restrictions set forth therein. For more 
information about Onset's licensing terms and policies, contact Onset Customer 
Service at 1-800-LOGGERS, or visit http://www.onsetcomp.com/legal. 

Thank you for purchasing Onset® products. Our loggers and software are designed 
to be easy to use, with many powerful capabilities. We recommend that you begin 
by installing the software, connecting your logger, and following the instructions in 
this manual to get up and running quickly. You can expect to be comfortable with 
HOBOware Pro fundamentals within a few minutes. Consult the HOBOware Pro 
User’s Guide on your installation CD or the online help for a more detailed 
description of software capabilities. 

Contact Information 

For support, please contact the company that you bought the products from: Onset 
Computer Corporation or an Onset Authorized Dealer. 

Onset Computer Corporation 
470 MacArthur Blvd. 
Bourne, MA 02532 

Mailing Address:  
P.O. Box 3450 
Pocasset, MA 02559-3450 

Phone: 1-800-LOGGERS (1-800-564-4377) or 508-759-9500 
Fax: 508-759-9100 
Hours of Operation: 8 AM to 5 PM ET, Monday through Friday 

E-mail: loggerhelp@onsetcomp.com 
Main Onset Web site: http://www.onsetcomp.com 

If you purchased the products through an Onset Authorized Dealer, you can also 
refer to www.hobohelp.com for support information. 

 

 

© 2003 – 2006 Onset Computer Corporation. All rights reserved. 

Part #: MAN-BHW-GS-PC 
Doc #: 10810-B 

Onset, HOBO, and HOBOware are trademarks or registered trademarks 
of Onset Computer Corporation for its data logger products and 
configuration/interface software. Microsoft and Windows are registered trademarks 
of Microsoft Corporation. Keyspan is a trademark of InnoSys Inc. All other 
trademarks are the property of their respective companies. 
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1: Introduction 

HOBOware Pro software is used for launching, reading out, and plotting 
data from HOBO data loggers. This manual explains how to: 

 Install and start the software 

 Connect loggers to the computer 

 Launch, log, and read out loggers 

For detailed information on all of HOBOware Pro’s features, use the online 
help or refer to the HOBOware Pro User’s Guide. The user’s guide (and 
help) offers full coverage of logger and other device functions, data and 
graph customization features, and an extensive collection of preferences. 

You can find the HOBOware Pro User’s Guide on your installation CD, or 
on Onset’s product manual web page: 
http://www.onsetcomp.com/Support/product_manuals.html 
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2: Installing HOBOware Pro 
To install the software from CD: 

1. Refer to the README file on the installation CD for detailed 
information about the hardware and software needed to run 
HOBOware Pro. If you have additional questions, please check the 
HOBOware website at http://www.onsetcomp.com/HOBOware, or 
call Onset Technical Support.  

2. Insert the CD in your computer’s CD-ROM drive. The installation 
program should start automatically. If it does not, navigate to the 
CD drive in My Computer or Windows® Explorer and double-click 
HOBOwarePro_Setup.exe to launch the HOBOware Pro installer. 

Tip: HOBOware Pro requires the Java 2 Runtime Environment. If 
the correct Java 2 Runtime Environment version is not 
already installed on your computer, the HOBOware Pro 
Setup program will ask if you want to install it now. (You 
must be logged in as an administrator on your computer to 
install the Java 2 Runtime Environment.) Click Yes and 
follow the prompts. After Java 2 Runtime Environment is 
installed, the HOBOware Pro installation will continue. 

3. Follow the prompts to install HOBOware Pro. 

4. HOBOware Pro should open automatically when the installation is 
complete (unless you uncheck the Launch HOBOware Pro box on 
the final dialog before clicking Finish). If it does not open by itself, 
double-click the HOBOware Pro icon on your desktop or Quick 
Launch menu. Or, from the Start menu, select Programs, Onset 

Applications, HOBOware Pro.  
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Using the HOBOware Setup Assistant 
When you open HOBOware Pro for the first time, you are greeted by the 
HOBOware Setup Assistant.  

 
The Setup Assistant is a series of dialogs intended to help you quickly 
change some key preference settings for device types and serial ports, units 
of measurement, and data assistants. Click Start to begin, and follow the 
prompts. 

The Setup Assistant is optional. If you click Cancel, you will be able to use 
HOBOware Pro with its default settings: 

• Support USB devices 

• Support Serial devices on COM1 

• Display data in US units 

• Enable all installed data assistants 

These are only a handful of the preferences available in HOBOware Pro. To 
see all of the preferences, or to run the Setup Assistant at any time, go to the 
File menu and choose Preferences. Click the Setup Assistant button to run 
the Setup Assistant, or click the icons to explore other preferences. Refer to 
“Preferences” in the HOBOware Pro User’s Guide for details. 
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3: Connecting devices 
HOBOware Pro supports HOBO U-Series data loggers and shuttles, which 
communicate with the computer by connecting to a USB port, as well as the 
HOBO Weather Station, HOBO Micro Station, and HOBO Energy Logger 
Pro loggers, which communicate with the computer by connecting to a 
serial port (or USB port with Keyspan™ serial adapter). 

You can connect most devices to the USB port by using an Onset-supplied 
USB interface cable. Some loggers require an optic USB base 
station/coupler or serial cable to connect to the computer. Consult the 
manual that came with your device for specific information about required 
base stations/couplers or cables. 

Tip: For instructions on connecting HOBOware Pro-compatible shuttles, or 
using the HOBO Waterproof Shuttle as a base station, refer to the 
shuttle’s user guide. 

Connecting a device to a USB cable 
1. Open HOBOware Pro. 

2. Plug the large end of the USB interface cable into a USB port on 
the computer. 

3. Plug the small end of the USB interface cable into the port on the 
device. (Refer to the diagram and instructions that came with the 
device if you need help finding the port.)  

4. If the device has never been connected to this computer before, it 
may take some time for the computer to detect the new hardware 
and report that it has connected successfully. One or more 
messages will appear, indicating that new hardware has been 
found. You may also hear a chime. 

Tip: Your computer may tell you to reboot before you can use the 
device. It is not necessary to reboot. 

5. When the device is recognized by HOBOware Pro, the right side of 
the status bar at the bottom of the HOBOware Pro window will 
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update to reflect the number of devices connected. At this point, 
you can begin using the device. 

6. To disconnect the device, simply unplug it from the USB cable.  

7. Wait for the status bar to update the number of devices before 
continuing. 

Connecting a base station/coupler and logger 
1. Open HOBOware Pro. 

2. Plug the base station/coupler cable into a USB port on the 
computer.  

Important: Make sure the base station/coupler is the correct 
model for the logger you want to use. Consult the manual that 
came with the logger if you are not sure. 

3. If you are connecting a base station/coupler that has never been 
connected to this computer before, it may take some time for the 
computer to detect the new hardware and report that it has 
connected successfully. One or more messages will appear, 
indicating that new hardware has been found. You may also hear a 
chime. 

4. Attach the logger to the base station/coupler as described in the 
documentation that came with your logger. 

If the logger has never been connected to this computer before, it 
may take some time for the computer to detect the new hardware 
and report that it has connected successfully. Again, there will be 
one or more messages and possibly a chime indicating that new 
hardware has been found. 

Tip: Your computer may tell you to reboot before you can use the 
logger. It is not necessary to reboot. 

5. When the logger is recognized by HOBOware Pro, the right side of 
the status bar at the bottom of the HOBOware Pro window will 
update to reflect the number of loggers connected. At this point, 
you can begin using the logger. 
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6. To disconnect a logger, simply unplug it from the base 
station/coupler. Wait for the status bar to update the number of 
devices before continuing. 

7. To attach another logger via a base station/coupler, remove the 
logger, leaving the base station/coupler connected. Then connect 
the next logger. 

8. To disconnect the base station/coupler, just unplug it from the USB 
port. 

Connecting a device to a serial cable 
1. Open HOBOware Pro. 

2. Plug the 9-pin end of the serial interface cable into a serial port on 
the computer or Keyspan adapter.  

3. Plug the other end of the serial interface cable into the 
communications port on the device. (Refer to the diagram and 
instructions that came with the device if you need help finding the 
port.)  

4. Click the Select Device icon  on the toolbar to ensure that the 
device is listed in the Select Device dialog. Click the button next to 
the logger in the dialog, then click OK. 

Tip: If you are using a serial port other than COM1, you will need 
to set up HOBOware Pro to look at another COM port. From 
the File menu, go to Preferences. Choose Communications 

and change the Serial Ports setting as needed. Note that 
checking multiple serial ports can take some time, even when 
no devices are attached. 

5. The status bar at the bottom of the HOBOware Pro window will 
update to reflect that the device is connected and selected. At this 
point, you can begin using the device. 

6. To disconnect the device, simply unplug it from the serial cable.  
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Connecting multiple devices 
If the computer has multiple USB and serial ports, you can connect multiple 
devices and work with one at a time. When multiple devices are connected, 
the Select Device window opens every time you choose the Launch, 
Readout, Stop, or Status command: 

 

Tip: If you would prefer not to see the Select Device window each time 
you launch, read out, stop, or check the status when multiple devices 
are connected, use the Preferences to turn off the feature. From the 
File menu, go to Preferences. On the General pane, choose Selecting 

Devices, and click the button next to the Only show Select Device 

window if a device has not been selected option. The selection 
window will then display automatically only when more than one 
device is connected and no device is selected. You can still access the 
window manually by clicking the Select Device icon . 

Click the button next to a device on the list to select it, then click OK. The 
launch, readout, stop, or status check will proceed with the selected device. 

If serial devices are selected in Preferences, it may take some time for 
HOBOware Pro to scan all of the serial ports. You can select the device you 
want as soon as it is displayed. You do not have to wait for all of the ports 
to be scanned. 

If the Blink Device Light button is available, you can click it to verify that 
you have selected the appropriate device. This briefly illuminates the light 
on the device that you have selected.  
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If the device does not have a light, or if the light is not visible when the 
device is in the base station/coupler, simply check the serial number (S/N) 
on your device to make sure that it matches the one that is selected in this 
window. 

To access the Select Device window at any time, click the Select Device 
icon  on the toolbar, or choose Select Device from the Device menu. 

When the Select Device window is not open, you can check the status bar at 
the bottom of the screen to quickly determine which device is selected.  

 
The left side of the status bar indicates the model, description, and serial 
number of the device; the right side indicates the total number of devices 
connected. (Serial devices that you have added or removed are not reflected 
in the device count until you click the Select Device icon  on the toolbar 
to update the device list.) 

If you work with multiple U-Series devices frequently, the Default Action 

option on the Device menu and the time-saving preferences may help you 
work more efficiently. Refer to “Working with multiple U-Series devices” 
and “General pane” in the HOBOware Pro User’s Guide for details. 
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4: HOBOware Pro Quick Start 
After you have installed and opened the HOBOware Pro software and 
connected a logger as described earlier in this manual, follow these steps for 
a quick demonstration of launching and collecting data with a logger: 

1. Click the Launch icon  on the toolbar. This displays the 
logger’s Launch window. Launch windows vary slightly for each 
type of logger, but most look similar to this: 
 

 
2. Review the default Launch settings and change them if you wish. 

Enter a new name in the Description field, and select or deselect 
Channels to Log (and connect appropriate sensors, if applicable). 
Make sure that at least one of the channels you log is a 
measurement of something that will be easy to change, such as 
light or temperature. Set a short (five seconds or less) Logging 

Interval, and choose the Now launch option. 
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Tip: Launch settings are discussed in depth in the HOBOware Pro 
User’s Guide. 

3. Click Launch to begin logging. HOBOware Pro displays the 
progress of the launch and warns you not to unplug the logger 
while it is being configured.  

Normally, you will unplug the logger and deploy it when the 
launch is finished. For this tutorial, leave the logger plugged in. 
 

 

4. On the toolbar, click the Status icon  to open the Status 
window. Watch as the Current Readings update in real time. 
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5. If you are using a U-Series logger that has a button, press and hold 
the button down for several seconds. Watch the Current States in 
the Status window change to Button Down. Release the button. 

6. Change the sensor readings by changing the conditions. For 
example, if you are measuring temperature, change the temperature 
reading by holding the logger or sensor in your hands for a minute 
or two. Watch the Current Readings in the Status window change 
as the conditions change. 

7. Close the Status window by clicking OK. 

8. Click the Readout icon  on the toolbar. Click Stop when 
HOBOware Pro asks if you want to stop the logger before reading 
out. 
 

 
9. After reading out the logger, HOBOware Pro prompts you to save 

the datafile. Click Save. 
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10. Review the settings on the Plot Setup dialog. The channels you 
enabled in step 2 should be checked, along with button and other 
events (if applicable). Click Plot. 
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11. View the results of your deployment. Your screen will not match 
this example exactly, but you should see Button Up and Button 
Down events (if applicable) and the graph should reflect the 
change in conditions that you caused in step 6. 

 

Increases in 
temperature & 
RH from step 6 

Details pane: Lists 
information about the 
launch and summarizes 
the deployment 

Status bar: Shows which 
device you are working 
with and how many 
devices are connected 

Graph: Diagrams 
the data 

Points pane: 
Lists the data in 
table format 

Toolbar: Click the icons 
to quickly access 
HOBOware Pro’s most 
frequently used functions

Legend: Displays the 
keys for each sensor, 
state, and event series 

Button push 
from step 5 
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12. Use the tools on the toolbar to experiment with the export, print, 
and many viewing and customization tools available within 
HOBOware Pro. Pause the pointer over each icon on the toolbar 
for a description of each tool.  

Tip: Viewing, customization, export, and print options are 
discussed in depth in the HOBOware Pro User’s Guide. 

13. Choose HOBOware Help from the Help menu. The browser-based 
Help system provides detailed information on all the features of 
HOBOware Pro, in convenient electronic form. 

14. If you have an Internet connection, choose Check for Updates 

from the Help menu. It is important to check for updates 
periodically. By default, HOBOware Pro automatically asks to 
perform this check each week. For more information about this and 
other preference settings, refer to “Preferences” in the HOBOware 
Pro User’s Guide.  
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5: Data assistants & plug-in tools 
Additional products are available to expand HOBOware Pro’s features and 
capabilities. Some are included with HOBOware Pro, and others can be 
purchased separately.  

Data assistants 
Data assistants let you create new data series by combining data recorded 
by the logger with additional data that you enter before you display the plot. 
For example, the kWh Assistant converts logged pulse data from an energy 
transducer to kWh, average kW, and energy cost. 

When you read out a logger or open a datafile, all available assistants are 
listed in the Data Assistants section at the bottom of the Plot Setup dialog. 
To use an assistant, click its name to select it, then click Process to proceed 
as described in the assistant’s help (accessed by the Help button on the 
assistant’s dialog) or user guide (located on the CD or web page where you 
downloaded the assistant). 
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For an overview of each assistant, select the assistant and click the What’s 

This? button. For instructions and more detailed information about 
supported data types and filters, refer to each assistant’s user guide. 

To prevent unwanted assistants from appearing in the Plot Setup dialog, or 
to bring back assistants that you have previously hidden, click the Manage 
button. This will open the Preferences dialog to allow you to change these 
settings. 

To install a new assistant, click the Load button. In the resulting file dialog, 
locate the assistant’s .jar file and click Open. If the new assistant is 
compatible with the series in this datafile, it will be added to the list of 
available assistants as soon as it is installed. If it is not compatible with the 
series in this datafile, it will still be loaded into HOBOware Pro, but will not 
be visible until you open a datafile with a compatible series.  

Plug-in tools 
Plug-in tools are software that works in conjunction with HOBOware to 
provide additional functionality. For example, the Real-Time Alarm 
Software monitors HOBO data loggers and notifies you when sensor and 
logger conditions fall outside the limits you specify. 

For instructions on installing and using plug-in tools, refer to the tool’s user 
guide (located on the CD or web page where you downloaded the tool). 

 

20 HOBOware Pro Getting Started Guide 

6: Toolbar icons 
The toolbar, located at the top of the main HOBOware Pro window, allows 
point-and-click access to HOBOware Pro’s most frequently used functions. 
Pause the pointer over each icon on the toolbar for a description of each 
tool. 

 Launch sets up the logger to begin logging. 

 Readout offloads data from the logger. 

 Status displays the logger’s state and current readings. 

 Stop stops a logging logger. 

 Select Device displays available devices. The accompanying pulldown 
allows you to specify whether you want HOBOware Pro to look for 
USB devices, serial devices, or both. 

 Open opens a .hobo or .dtf file. 

 Save saves the plot as a project (.hproj) file. 

 Close closes the currently focused plot. 

 Export creates a text file of the data (in .csv or .txt format) for use in 
spreadsheet and other applications. 

 Print prints the graph as it appears on your screen. 

 Arrow points to and selects items on the graph to edit their properties. 

 Crosshair displays values for points on the graph and cross-references 
them to cells in the Points table. 

 Hand scrolls an axis or the entire graph. 

 Zoom adjusts the scaling of an axis or the entire graph. 

 Subset statistics lets you view statistics for a particular time span. 
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 In zooms in on a smaller area of the graph. 

 Out zooms out to a larger area of the graph. 

 Revert rescales the graph to full scale. 

 Properties modifies the properties of various graph items. 

 Vertical Gridlines toggles vertical gridlines on and off. 

 Horizontal Gridlines toggles horizontal gridlines on and off. 

 Mark Points toggles all point markers on and off. 

 Units allows you to convert some or all of the series on the currently 
focused plot to other units (for example, from degrees Fahrenheit to 
degrees Celsius). 

 Help opens HOBOware Pro’s browser-based Help pages. 
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L 
Light, 10 
Logger: connecting, 7–11; disconnecting, 8, 9; multiple, 10–11 

M 
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Q 
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S 
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Setup Assistant, 6 
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